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I. Introduction

Reducing greenhouse gas (GHG) emissions can be accomplished through policies, programs or projects
conceived specifically for that purpose. Or it can be achieved with policies, programs or projects designed
to meet immediate development priorities such as improving urban air quality, water quality, and waste
management while taking into account longer term climate concerns. Policies, programs, or projects
considering both development and climate objectives can deliver co-benefits.

Effective approaches to co-benefits are likely to vary greatly between regions. In general, the ease of
implementing a co-benefits approach will vary inversely with the scale and complexity of existing
policies. Thus, the less developed a country’s air pollution and climate policies, the easier it is to institute
a co-benefits approach. But while this makes Asia a promising region for co-benefits, factors varying
within the region, such as stages of economic development, merit consideration as they may contribute to
interregional variation.

In recent years, a variety of stakeholders in Asia have demonstrated that integrating co-benefits into
decision-making processes can reduce GHG mitigation costs or bring carbon finance to development
needs. However, the absence of a mechanism to share information and coordinate stakeholders on these
issues has hampered mainstreaming co-benefits into national development strategies and plans as well as
sectoral policies, programs, or projects in Asia.

In June 2009 during the first International Forum for a Sustainable Asia and the Pacific (ISAP) in
Hayama, Japan, panelists in a plenary session on co-benefits proposed creating an informal network to
improve information sharing and stakeholder coordination on co-benefits in Asia. Over the last year,
representatives from government agencies and leading international organizations held follow-up
meetings in Bangkok, Thailand to further define the goals, membership, functions and activities, and
implementing arrangements for an “Asian Co-benefits Partnership” (henceforth the Partnership).

Findings from the past year of co-benefits meetings included:

e A co-benefits approach has received a growing amount of attention in Asian countries, especially
from government officials.

e Some countries and several international organizations as well as initiatives have been working
intensively on a co-benefits approach in Asia.

e Several model co-benefits projects (i.e. methane recovery from wastewater treatment in Thailand)
and joint co-benefits studies (i.e. Panzhihua and Xiangtan, China; Banjarmasin and Palembang
City, Indonesia) are already underway in Asia. Cost savings from incorporating co-benefits into
projects seem to be particularly significant in Asia. Sharing experiences and lessons learned from
these projects can help advance a co-benefits approach.

o While many co-benefits projects require involvement of various stakeholders, there are
significant communication gaps as well as limited awareness among relevant stakeholders in Asia.



e Translating co-benefits from a concept into a practice requires integration of a co-benefits
approach in and across sectoral policies, especially buildings, energy, industry, transport, and
waste management policies. Sectoral integration and application is important because it
represents the realization of a co-benefits approach.

e Several organizations have started to create tools to help operationalize a co-benefits approach.
Methodologies for co-benefits analyses must be developed, refined, and disseminated widely.
Intensive capacity building activities should be undertaken to familiarize stakeholders with such
methodologies.

e A co-benefits approach applies to policymaking at the local, national, regional and global level. It
will be increasingly important that policymakers at all levels become familiar with co-benefits. It
is nevertheless particularly important to integrate co-benefits into criteria and methodologies for
international funding mechanisms.

e The interactions between atmospheric pollution and climate systems are an increasingly
promising area for co-benefits in Asia. These interactions, especially those involving short-term
warming agents such as black carbon and tropospheric ozone, need to receive greater attention in
Asia. This attention would come in addition to work on co-benefits between environmental
pollution and six greenhouse gases under the Kyoto Protocol.

I1. Proposed Structure of the Partnership

A. Goal
The ultimate goal of the Partnership is to support the mainstreaming of co-benefits into sectoral
development plans, policies and projects in Asia. The Partnership will serve as an informal and interactive
platform to improve information sharing and stakeholder coordination on co-benefits in Asia. The
Partnership will also seek to build on and complement existing networks/initiatives that offer financial
and other forms of non-material support to help realize that goal.

The following are envisioned outcomes of the Partnership:

e Knowledge base and information clearing house on co-benefits have been established to
improve and disseminate to various stakeholders in Asia, especially to policymakers;

o Effective communication structures on co-benefits have been created which include all major
organizations and initiatives promoting a co-benefits approach;

« National and sectoral policies in Asia incorporate co-benefits and result in increased number of
specific co-benefits projects; and

* Cooperation among countries in Asia for further promotion of mutually-beneficial co-benefits
approach/projects has been strengthened.

B. Partnership members and target audience

Partnership members may include various stakeholders working on co-benefits in Asia, including
government agencies, international development organizations, academe, civil society and the private
sector etc..



Since the Partnership is an informal platform, any organization or individual that is interested in or
willing to work on co-benefits in Asia can join the Partnership and contribute to activities described in the
work plan.

Views on co-benefits are inherently diverse (see Appendix for varying definitions of co-benefits). Some
groups are interested in the linkages between climate change and development while others focus on
linkages between climate and particular sectors (energy, transport, and industry) or environmental media
(air, water, and waste). To ensure the inclusive character of the Partnership, co-benefits will be viewed in
a broad sense — that is, co-benefits between development and climate.

Many members in the Partnership will place a higher priority on co-benefits between environmental
pollution and climate, with several members focusing specifically on air pollution and climate change.
The Partnership recognizes that a narrower focus will be useful to mainstreaming co-benefits into specific
sectoral policies and measures. At the same time, a broader purview will help raise awareness of co-
benefits among the variety of stakeholders involved in formulating and implementing relevant policies
and measures.

The Partnership aims to encourage the wide scale application of a co-benefits approach; the Partnership is
designed to meet the needs of organizations (especially government agencies from developing countries
in Asia) that are responsible for the formulation and implementation of sectoral policies, programs and
projects. Since local level agencies frequently implement projects and policies, the Partnership will make
concerted efforts to ensure its activities reach down to the local level.

The Partnership will also target organizations and persons promoting co-benefits in nationally appropriate
mitigation actions (NAMAS) or in global or regional assistance programs under multilateral development
banks.

Researchers will play an important role in the Partnership, recognizing that in an evolving area such as
co-benefits researchers can bring recent findings to other stakeholders.

C. Major functions and activities

The major functions and activities of the Partnership are:

1. Information sharing and knowledge management, including knowledge generation and
dissemination

. Knowledge management activities should be strongly promoted. Such activities may include: (a)
research on the science behind co-benefits; (b) defining possible co-benefits policies at the
national development or sectoral levels; and (c) methodologies to quantify co-benefits. Members
of the Partnership already possess extensive knowledge on co-benefits, and have published
research papers, technical documents, case study reports etc. The Partnership will gather and
disseminate knowledge in a structured manner to Partnership members as well as other relevant
stakeholders.

. Information sharing and a clearing house system will help manage and share information of co-
benefits in Asia, and to promote the mutually-beneficial projects, especially through
demonstrations projects.



2. Enhanced communication among the Partnership members

J The Partnership Secretariat will identify organizations that are involved in co-benefits policies or
projects, invite them to join the Partnership, and contribute actively to their activities.

. The Partnership will collaborate with relevant members to utilize and enhance existing websites
to share information related to co-benefits.

. One of the barriers to disseminating a co-benefits approach is a limited understanding of its

application to actual projects. There are effective co-benefits projects in Asia whose experiences
can be shared among stakeholders. Sharing of experiences on model projects in different sectors,
such as transport, air pollution control, or waste management, will be encouraged and facilitated
by the Partnership.

. Seminar/s and workshop/s will be held to exchange experiences and views on concepts, policies,
and methodologies on a co-benefits approach and case studies of co-benefits policies and projects.

3. Development of co-benefits policies and projects in Asia

. Joint research will be initiated and undertaken on how to integrate co-benefits policies in national
development plans as well as relevant sectoral policies. Given the importance of cross-national
cooperation, bilateral and multilateral research projects will need to be promoted.

. The Partnership will provide new opportunities for collaboration on specific co-benefits projects
Guidelines, manuals, and other technical documents to develop and evaluate co-benefits policies
and projects will be developed and disseminated.

. Capacity building needs for a co-benefits approach (both at the policy and project level) will be
identified. Based on the identified needs, capacity building activities will be developed and
implemented as appropriate.

. When resources are available, demonstration projects may be developed and implemented to
demonstrate the utility of co-benefits approach.

4. Strengthening of regional cooperation to promote co-benefits approach

. Inter-linkages will be established between the Partnership and existing networks/initiatives in
Asia potentially related to a co-benefits approach. The issue of co-benefits will be raised at high
level policy dialogues. Efforts will be made to raise awareness on co-benefits among high level
policymakers in Asia through appropriate regional and international (such as the Joint Forum on
Atmospheric Environmental Issues).

. An appropriate funding scheme, as well as better use of existing funding schemes, may be
explored to promote/accelerate co-benefits policies and projects in Asia. Funding from
international and regional development agencies may be pursued to finance model projects.

D. Implementation arrangements

The Secretariat for the Partnership will be the Institute for Global Environmental Strategies (IGES). The
main tasks of the Secretariat will include:



o Develop documents on Partnership activities including Partnership work plans for review and
comments by Partnership members;

e Oversee implementation of Partnership work plan;

e Organize and promote Partnership activities, including meetings, seminars, workshops;

e Maintain communication with Partnership members;

o Assist members of the Partnership in developing co-benefits policies and projects in Asia; and

e Carry out other activities as appropriate.

The Secretariat will have a special responsibility to ensure active participation of Asian countries in
Partnership activities.

An Advisory Group will be set up to provide advice to the Secretariat on the Partnership and its activities.
The functions of the Advisory Group will include:

e Setand review strategic priorities for the Partnership;

* Review the Partnership work plan prepared by the Secretariat;

e Recommend the working method (including membership policy) of the Partnership; and

¢ Advise on fund raising activities carried out by the Partnership members to support the
Partnership activities

Members of the Advisory Group are comprised of representatives from some Asian countries and
international organizations. The membership of the Advisory Group will ensure that the priorities of
Asian countries are adequately reflected in the activities of the Partnership.

Initial members of the Advisory Group may be:

e Asian country representatives: volunteer countries;

e International organizations: the Asian Development Bank (ADB), the Clean Air Initiative for
Asian Cities (CAIl-Asia), the Global Atmospheric Pollution Forum (GAPF) and the United
Nations Environment Program (UNEP); and

e Others as appropriate, such as selected sectoral agencies.

The Advisory Group will maintain contact by email and/or teleconferences and will have a minimum of
one face-to-face meeting each year.



1. Work Plan 2010-2011

The work plan lists a wide range of activities that will be assessed, prioritized, revised and updated, by
using the PDCA cycle (plan do check act) in due course.

Organization to

Function Activities Timeframe
play the Lead role
Information - Develop or improve appropriate
sharing and websites/listserv on knowledge management
knowledge » Clean Air Portal and the CitiesACT portal | CAl-Asia
management (co-benefits policies and co-benefits Initial website
projects_ in place
» Kyoto Mechanisms or AP Gateway MOE-J Already set up
Website
» Climate Change Group Website ( main IGES

external Partnership website)
Collect and provide the latest scientific
information on co-benefits
Develop information kits (electronic and
printed matter) on co-benefits to disseminate
among policy makers and other potential
stakeholders
Information clearinghouse

Formulation common research agenda on co-
benefits

Documenting research activities on co-benefits
by Partnership members and others

Conduct assessments of awareness on, and
application of, a co-benefits approach in
selected Asian countries

GAP Forum/UNEP

CAI-Asia/IGES

UNEP/RRCAP

IGES and other
members
Secretariat

IGES and other
members

Any time

Ongoing basis
Initial one
before BAQ
2010/COP 16

2011

2010- first half
2011

Communication

Conduct consultation workshops in selected
Asian countries on barriers and opportunities
for co-benefits in Asia

Convene seminars/workshop to widely
disseminate a co-benefits approach to
policymakers and other stakeholders.

» A Seminar on a Co-benefits Approach
Provide relevant regional existing initiatives
with information/input on co-benefits,
including but not limited to:

A. General meetings on Climate Change and Air

Pollution

» Asia-Pacific Seminar on Climate Change

IGES supported by
members

IGES

IGES

IGES/MOE-J

2010- first half
2011

As appropriate




Organization to

Function Activities Timeframe
play the Lead role
» Acid Deposition Monitoring Network in
East Asia (EANET) UNEP ditto
» Malé Declaration on Control and
Prevention of Air Pollution and its Likely | UNEP ditto
Transhoundary Effects
» Joint Forum on Atmospheric Environment
in Asia and the Pacific UNEP ditto
» Atmospheric Brown Cloud (ABC) Project
» Thematic Working Group on Air Quality | UNEP ditto
under the Regional Forum on
Environment and Health UNEP ditto
» Regional Climate Change Adaptation CAl-Asia
Knowledge Platform for Asia
» The Compliance Assistance Programme UNEP ditto
(CAP) under the Montreal Protocol on
Substances that Deplete the Ozone Layer
» Greenhouse Gas Emission Reduction from | UNEP ditto
Industry in Asia and the Pacific
(GERIAP)
» The Better Air Quality (BAQ) Meeting IGES/MOE-J ditto
» Stockholm Process
<+ A process initiated by the GAP IGES/MOE-J ditto
Forum’s Management Group to CAI-Asia/IGES Nov. 2010
enlist wider support for GAP Forum/IGES

international strategies which can
integrate climate change and air
pollution policies.

» IUAPPA World Clean Air Congress

B. Sustainable Transport
» Regional Environmentally Sustainable GAP Forum Sep. 2010
Transport (EST) Forum

» Partnership on Sustainable Low Carbon SLoCaT

Transport (SIoCAT)

» ADB Transport Forum and STI-OP ADBTBD
implementation

» To be updated TBD

C. Clean Energy
» Clean Energy Forum
> To be updated.
IGES/ MOE-J
D. Water and Waste
» Water Environment Partnership in Asia IGES/ MOE-J
(WEPA)
> 3R Initiative in Asia




Organization to

Function Activities Timeframe
play the Lead role
Co-benefits - Conduct gap analysis in terms of tools and IGES November
policies and methodologies for co-benefits 2010
projects - Develop and/or improve technical documents
for co-benefits projects
» Co-benefits technology map IGES Drafted
» Technical manual for quantitative MOE-J Drafted
evaluation
» Transport co-benefits manual (TCM) IGES In process
» Clean Air Scorecard CAl-Asia Available
» Integrated GHG and AP Emissions CAl-Asia Available
Accounting Tools for Companies
» The GAPF Emissions Manual GAP Forum Available
» NAMA Guidelines SLoCaT Drafted
- Initiate additional activities on tools and IGES 2011
methodologies, based on gap analysis
- Prepare case study reports on co-benefits IGES/ CAl-Asia March 2011
projects (sectoral projects), including:
» Field testing of TCM on public transport IGES/CAI-Asia Ongoing
projects in the Philippines and Thailand
» China Green Freight Project CAl-Asia Ongoing
» China Co-benefits Cities Project CAl-Asia Ongoing
» Sustainable Transport Initiative (STI) ADB Ongoing
- Support the development of integrated co- IGES supported by | 2011
benefits strategies for selected developing other members
countries in Asia
- Develop co-benefits projects, led by IGES supported by | 2011
developing country Partnership members other members
Regional - Develop a co-benefits framework for dialogue | IGES supported by | Before COP 16

cooperation

among policymakers in selected countries in
Asia

Develop policy messages for high level
policymakers

Develop appropriate financing framework for
co-benefits policies and projects in Asia,
including better use of existing funding
mechanisms

other members

All relevant
organizations

IGES for draft
development

in Dec. 2010

Dec. 2010

TBD




Annex 1
Definitions of Co-benefits
“Benefits that accrue as a side effect of a targeted policy.”

-Pearce, D. “Policy Frameworks for the Ancillary Benefits of Climate Change Policies”. CSERGE Working Paper

GEC 2000-1. http://www.uea.ac.uk/env/cserge/pub/wp/gec. p. 1.

“The benefits of policies that are implemented for various reasons at the same time—including
climate change mitigation—acknowledging that most policies designed to address greenhouse
gas mitigation also have other, often at least equally important rationales (e.g. related to
objectives of development, sustainability, and equity). The term co-impact is used in a more

generic sense to cover both positive and negative side of benefits.”

-Intergovernmental Panel on Climate Change (IPCC) (Fourth Assessment Report). Climate Change, 2001:
Mitigation. B. Metz, O. Davidson, R. Swart. and J. Pan. (eds.) Cambridge: Cambridge University Press, 2001. p.
711.

“All of the positive outcomes associated with multiple, simultaneous emissions reductions.”

-Fitzgerald, J. and Villarin, J. R.T. United States Environmental Protection Agency. Integrated Environmental
Strategies (IES) Program. Presentation at 2005 International Conference on Atmosphere Protection. CGE Training

Workshop on Mitigation Assessments, Seoul, Korea, September 2005.

“[The] potentially large and diverse range of collateral benefits that can be associated with

climate change mitigation policies in addition to the direct avoided climate impact benefits.”

-Bollen, J. Guay, B. Jamet S. and Corfee-Morlot, J. “Co-benefits of Climate Change Mitigation Policies”.
Economic Department Working Papers No. 693. Paris: Organisation for Economic Cooperation and Development

(OECD), 2009. p. 5.





